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This document describes the setup and operation of Doppler Systems' TargetTrack software.  
TargetTrack is designed to provide a user interface the Doppler radio direction finders or a network 
of Doppler radio direction finders.  Updates and upgrades to this software are available on our 
website http://www.dopsys.com/software/downloads.html.   

 
 

TYPOGRAPHICAL CONVENTIONS 

Before you start using this guide, it is important to understand the terms and typographical 
conventions used in the documentation. 

For more information on specialized terms used in the documentation, see the Glossary at the end 
of this document. 

The following kinds of formatting in the text identify special information. 

FORMATTING CONVENTION TYPE OF INFORMATION 

Triangular Bullet() Step-by-step procedures. You can follow 
these instructions to complete a specific 
task. 

Special Bold Items you must select, such as menu 
options, command buttons, or items in a 
list. 

Emphasis Use to emphasize the importance of a point 
or for variable expressions such as 
parameters. 

CAPITALS Names of keys on the keyboard. for 
example, SHIFT, CTRL, or ALT. 

KEY+KEY Key combinations for which the user must 
press and hold down one key and then 
press another, for example, CTRL+P, or 
ALT+F4. 
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B 
BEACON 

A transmitter at a known location on a known 
frequency that can be used for calibration 
 

C 
CEP 

CEP stands for Circular Error Probability.  It is 
defined as the radius of a circle, centered 
about the target, whose area is equivalent to 
the area of the EEP ellipse. 
 

CEP THRESHOLD 

When the CEP threshold is met the color of 
the EEP ellipse on the map changes color and 
the target text in the target display changes 
color. 
 

D 
DIRECTION FINDING NETWORK 

A Direction Finding (DF) Network consists of 
two or more direction finders located at 
distinct locations that are interconnected via a 
local area network (LAN), a wide area 
network (WAN), the Internet, or via radio 
modems. 
 

DIRECTION FINDING SITE 

A location where a direction finder, receiver, 
and a means of communicating with a 
computer running the TargetTrack software 
are located. 
 

E 
EEP 

EEP stands for Elliptical Error Probability.  
TargetTrack estimates the location of the 
target and draws it on the map.  Additionally it 
draws and ellipse around the target.  EEP 
represents that under ideal direction finding 
conditions, there is a 95% probability that the 
target is somewhere within this ellipse. 
 

I 
INTERCEPT 

Reception of a signal by the direction finder 
that causes TargetTrack to record audio and 
bearings.  The duration of the intercept will be 
the time the signal is on the air. 

 
 

P 
PRIMARY SITE 

Site that serves as the primary location and is 
where the direction finder audio source 
originates. 
 

S 
SITE QUALITY 

The site quality refers to the expected 
magnitude of the bearing error.  Direction 
finding bearing error is affected by the 
environment in which the direction finding site 
is installed in.  In a fixed site, the ideal location 
is where the antenna is mounted at a high 
point on top of a pole or tower and there are 
no other metallic objects around it.  This type 
of environment gives the antenna a clear line-
of-site to the target and minimizes the 
possibility of reflections.  In a mobile site a 
good location consists of a high point clear of 
metallic objects such as power lines and clear 
of large objects such as hills.  Unfortunately, it 
is not always possible to locate the direction 
finding site at a good location.  As a result the 
bearing error can increase.  Adjusting the site 
quality instructs the targeting algorithm to 
assume the bearing has a certain standard 
deviation depending on the setting.  This 
affects the size of the EEP ellipse. 
 

T 
TARGET 

The estimated location of a radio frequency 
source. 
 

GLOSSARY OF TERMS 
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TRANSCRIPT 

User entered textual data that provides 
descriptive information on an intercept 
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To install TargetTrack insert the installation USB thumb drive into your computer or download and 
unzip the installation software from our website.  Double click on Doppler.exe.  If downloading from 
the web site, unzip the downloaded file and launch the Doppler.exe application.  A screen shot of the 
installer is shown below.  Press the Install TargetTrack button.  TargetTrack requires SQL Server 
Compact Edition.  If this software is not installed on your computer then the installer will 
automatically install it.  After TargetTrack is installed press the Quit button. 
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TargetTrack offers three mapping options 

- Great Maps 

- User generated maps  

- ESRI ArcGIS mapping engine 

This section will describe the mapping options in detail 

IN THIS CHAPTER 

Using Great Maps ................................................................................................... 9 
Creating Maps Using MapFix .............................................................................. 15 
Using the ESRI ArcGIS Mapping Engine ........................................................... 21 
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USING GREAT MAPS 

Great Maps is an open source mapping utility that uses online map data from various providers to 
generate and display maps for use in TargetTrack.   More information on Great Maps can be found 
on the GMap.Net web site https://github.com/radioman/greatmaps.   The map data is immediately 
displayed and is then downloaded in the background into a local map database so that the 
downloaded maps can be used when TargetTrack is disconnected from the Internet.  To build a local 
map database the user simply needs to select the area of interest and wait for the software to 
download and save the map data.  Once the map data is downloaded the user can disconnect the 
computer from the Internet and continue to use the downloaded maps.  This allows the user to use 
TargetTrack in a mobile application where a connection to the Internet may not be available. 

The figure below shows the GMap.Net utility installed in TargetTrack.  The utility consists of a 
display pane and a tool bar that can be used to manipulate the maps. 

 

 

Note: Great Maps uses various providers to supply mapping data.  These providers may 
have terms of use provisions.  The user is responsible for conforming to the provider's 
terms of use. 

 
 

Figure 1: Typical Great Maps Display 
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MAP MENU 

The Map menu is used to select the mapping provider and to export and import map data from the 
local map database.  The figure below illustrates the Map menu selections. 

 
 

MAP PROVIDERS 

The map providers menu allows the user to select which map provider will be used to display the 
map.  The figure below shows the menu with three providers installed and OpenStreetMap selected.  
Changing the map provider will download data for the region of interest from the map provider 
selected. 

 
 

Figure 2: Great Maps Menu 

Figure 3: Use Map Provider to Select the Mapping Data Provider 
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SELECT MAP PROVIDERS 

Select Map Providers allows the user to pick which map providers will appear in the Map Providers 
menu.  There are a large number of map data providers and the user will probably use a limited 
number.  For example in an urban area when operating mobile the user may want a street map and a 
map displaying imagery.   Choosing Select Map Providers displays the following dialog 

 

To add a map provider to the Map Provider menu select the desired map provider from the 
Available Maps list and press Add.  To remove a provider select the map provider from the 
selectable maps list and press Remove. 
 

SHOW PLACEMARKS 

If you've added placemarks to your map you can disable the display of the placemarks by unchecking 
this menu item. 

 
 

EXPORT MAP TO FILE 

Export Map to File allows the user to save the currently displayed map to a file and then import 
the map data into a database on a different computer running TargetTrack.  Selecting Export Map 
to File displays a standard Windows save file dialog. 
 

Figure 4: Build the Map Provider Menu by Selecting the Map Providers You Want to Use 
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IMPORT MAP FILE TO DATABASE 

Import Map File to Database allows a user to import a previously saved map (.gmdb) file into the 
mapping database.  This feature allows map data from one computer to be easily added to the 
database on another computer. 
 

EXPORT DATABASE TO FILE 

Export Database to File allows the user to export the entire mapping database into a file.  This 
file can then be imported on another computer running TargetTrack.  

 
 

PLACEMARKS 

If placemarks have been added to the map they can be exported or deleted using the Placemark 
menu.  Exported placemarks can be imported using the Import menu selection 

 
 

CLEAR MAP CACHE 

This menu item will clear out the maps that are stored in the map database on your computer.  
Once you've cleared the cache the maps will no longer be available if you are not connected to the 
Internet.  The maps will be freshly downloaded when you are connected to the Internet.  Use of this 
menu selection is only recommended if you suspect that your mapping database is corrupted. 

 
 

OPEN MAP 

Open Map opens a saved ESRI or bitmap image based map. 
 

TOOLS 

A variety of tools are provided to manipulate the map and objects on the map.  The figure below 
defines the tools. 

 

Figure 5: Great Maps Tool Bar 
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 Select - Pressing select makes it possible for the user to select sites and to right click on the map 
to add or delete sites. 

 Zoom In - Zoom In activates the zoom in tool allowing the user to select an area and zoom in 
on that area 

 Zoom Out - Zoom Out activates the zoom out tool allowing the user to select an area and 
zoom out with that area in the center of the zoom.  A smaller zoom out area will result in the 
largest area covered 

 Pan - Pan activates the pan tool allow the user to scroll the map. 
 Reposition Sites - This tool allows the user to click on and drag sites to another location on the 

map.  Sites with GPS receiver installed cannot be repositioned. 
 Previous Extent - Previous Extent allows the user to undo a previous map manipulation (e.g. 

zoom or pan) 
 Next Extent - Next Extent allows the user to redo a previous map manipulation (e.g. zoom or 

pan). 

KEYBOARD SHORTCUTS 

The arrow keys can be used to pan and zoom the map. 

 ↑ Up Arrow scrolls the map upward 

↓ Down Arrow scrolls the map downward 

→ Right Arrow scrolls the map to the right 

← Left Arrow scrolls the map the the left 

Shift ↑ zooms in the map one level 

Shift ↓ zooms out the map one level 
 

DISPLAY MENU 

The display menu allows the user to set the format of display for latitude and longitude.   The 
options are shown in the figure below. 

 
 

Figure 6: Choose the Format of the Geographic Location Display 
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DOWNLOAD INDICATOR 

The download indicator alerts the user to the status of the map database.  If the indicator is green 
then the map data displayed on the screen has been saved to the database.  If the indicator is fuchsia 
then the data is in the process of being downloaded. 
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CREATING MAPS USING MAPFIX 

Maps are required to display the bearing data and the estimated location of the radio frequency 
emitter.  To create a TargetTrack bitmap based map use the MapFix program, which is installed on 
your hard disk in the same directory as TargetTrack.  An icon for MapFix is placed in your Doppler 
program group.  With MapFix you can import an image and assign latitude and longitude coordinates 
to it.  Then save the file and you are ready to use the map in TargetTrack. 

Technically, a TargetTrack map is a pixel-based image (a bitmap) that is stored in a file together with 
coordinate information. To make a map, you must first create a map image and store it in a graphics 
file.  You can create a map image by using a commercially available map program or by using a 
scanner.  When you have such a file, you import it to Map Fix. The next step is to assign coordinates 
to the image. When you have assigned coordinates, you can check the coordinates of any location by 
moving the mouse. The latitude and longitude of the cursor location are displayed at the top of the 
screen. Finally, you save the image with coordinates as a map file. 

There are some things you should consider when making a TargetTrack map. If the map has many 
details and/or is very dark, you might find it hard to see bearings on the screen. It is advisable to use 
a map with fairly pale colors or with limited detail.  

 





  17 

 

 17
 

CREATING A MAP IMAGE 

To make a map you first need a graphics file containing a map image. You cannot use MapFix to 
create this file. A convenient way of making a graphics file is to use a map program (see "Using 
Microsoft MapPoint" on page 18). Alternatively, you could scan in an image from a hard copy map 
or obtain one from a web site such as Google Earth or Google Map. You can even use a photograph 
of a map if you would like.  Since graphics files consume space on your hard disk, you might want to 
delete them after you have used them to make TargetTrack maps. 
 

GRAPHICS FILE FORMATS 

There are a great number of file formats for storing images. Almost all of these are pixel based. A 
given format can usually store several kinds of images (different numbers of colors per pixel and 
different compression schemes). It is also possible to store an image as graphics drawing commands 
(the Windows Metafile Format is of this type). Map Fix only handles can open JPEG (.jpg), bit map 
(.bmp). or GIF (.gif) files.  Common programs such as Microsoft Paint or Microsoft Imager can easily 
convert any standard graphics file into a suitable image. 
 

SCANNING IN AN IMAGE 

If you create a map image by scanning it in from an image on paper, make sure that you orient the 
paper image with north in the upward direction, so that latitudes become horizontal and longitudes 
vertical. If the latitude and longitude lines on your map are not clearly visible make sure to mark the 
latitude and longitude of two points on your map (preferably near diagonal corners).  You then use 
your scanning software to save the image as a graphics file. 
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USING GOOGLE EARTH 

Google Earth provides an excellent interface for making map images for TargetTrack.  Use the 
following guidelines to create a map.  See the Google Earth help file for more information on using 
Google Earth. 

 Install Google Earth per instructions found at www.earth.google.com (see Google Earth - 
http://www.earth.google.com) 

 Run Google Earth and use the controls to select the area of interest 

 Make sure the Sidebar is showing.  If it is not showing then select it in the View menu 

 In the Sidebar click on the features you want to show on your map.  Typically you would select 
roads as a minimum 

 In the View menu uncheck all items except Status Bar 

 Press the F11 key to expand the view to full screen 

 Use the Placemark selection in the Tools menu to add two placemarks to the map.  Note the 
longitude and latitude of each placemark.  It is best to select placemarks near diagonally 
opposite corners of the map 

 Press Ctrl+Alt+C to copy the map image to the clipboard 

 Launch a graphics program such as Microsoft Paint and paste the image on the clipboard 
into the program. 

 Save the image as a bitmap 

USING MICROSOFT MAPPOINT 

Microsoft MapPoint or other similar mapping software applications can also be used to create maps.  
To use Microsoft MapPoint follow the instructions below. 

 Launch Microsoft MapPoint and select the area of interest 

 Use the Options menu (MapPoint 2006 or later) to display the longitude and latitude in 
degrees minutes seconds 

 Select Location Sensor from the  Tools menu 

 Use pushpins from the toolbar at the bottom of the display to mark two locations on the map.  
Note the longitude and latitude of each location.  It is best to select locations near diagonally 
opposite corners of the map. 

 Press Ctrl+Shift+C to copy the map onto the clipboard 

 Open a graphics program such as Microsoft Paint and paste the map image into the program. 

 Save the image as a bitmap 
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USING MAPFIX 

MapFix is a utility program supplied with TargetTrack used to convert the bitmap files of the maps 
you've saved into map files that can be used with TargetTrack. 
 

IMPORTING THE IMAGE 

To import a graphics file containing a map image to Map Fix, select the Import option from the File 
menu or click the Import button on the tool bar. A file open dialog appears.  Then go to the 
directory where the graphics file is located, select the file and click OK. The map image then appears 
on the screen 
 

ENTER CALIBRATION POINTS 

Using commands in the Enter Points menu or on the tool bar, you assign coordinates to your pixel 
image by specifying the latitude and longitude or MGRS coordinates of two locations on the image. 
Thus, you need to know the location of two points that you can identify and select with the mouse. 
You are free to choose any two points, except that they must define a rectangle (they cannot line 
up). To achieve maximum precision, you should see to it that the two points are fairly far apart, 
preferably along a diagonal of the image. The following commands appear in the Enter Points menu:  

Fix Point 1: Determine the location and coordinates of the first point. When you select this option, 
the cursor changes to a cross. Move the cross to the first location and click the mouse. Enter the 
latitude and longitude or MGRS coordinates of the location in the dialog box that pops up. The 
location you have chosen is marked in red on the screen. If you are not satisfied, select Clear 
Point 1 from the Enter Points menu and repeat the process. 

Fix Point 2: Determine the location and coordinates of the second point. When you select this 
option, the cursor changes to a cross. Move the cross to the second location and click the 
mouse. Enter the latitude and longitude or MGRS coordinates of the location in the dialog box 
that pops up. The location you have chosen is marked in blue on the screen. If you are not 
satisfied, select Clear Point 2 from the Enter Points menu and repeat the process. 

Clear point 1 and Clear point 2: Use these options if you want to start over fixing points. 

 

 

Figure 7: Enter Position of the Point Where You Clicked 
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After you have entered both points the map is now calibrated.  As a test of the calibration you may 
move the mouse to other known locations and read the position from the tool bar.  If there is a 
discrepancy then you may have made a coordinate entry mistake.  To correct the mistake simple 
clear the fixed points and start over. 
 

SAVING THE MAP FILE 

Use the Save Map As option in the File menu to open a dialog where you can save the map image 
with coordinates to file. The file name extension for a TargetTrack map file is .MAP.  Type in the map 
name you wish to use in TargetTrack.  If you save the map to the Map subdirectory, TargetTrack will 
automatically load these maps when the program is first started.  However, you may save the maps 
anywhere on your hard disk.  Saving a map is available only after you have imported a graphics file 
and fixed the coordinates of two points on the map 
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USING THE ESRI ARCGIS MAPPING ENGINE 

This section provides instruction on how to use ESRI maps in TargetTrack. 
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INSTALLING AND LICENSING THE ESRI ARCGIS MAPPING ENGINE 

Prior to using the ArcGIS Mapping Engine, you must obtain a license to use the engine on your 
computer.  This license may be obtained from Doppler Systems LLC or it can be obtained directly 
from ESRI (www.esri.com http://www.esri.com).  We do not recommend installing the Mapping 
Engine until you acquire the license. 

 Installing the mapping engine 

To install the ArcGIS Mapping Engine, insert the installer CD and wait for the Doppler installer 
program to launch.  If it does not launch, use Windows Explorer to navigate to the CD and double 
click on Doppler.exe.  Push the Install ESRI ArcGIS Mapping Engine button and follow the 
instructions on the screen.  

 Obtaining the License File 

To install the license you must use the license number you were provided to get a license file from 
ESRI.  Go to the Start menu and select ArcGIS->Software Authorization to display the 
following dialog: 

 

Figure 8: Dialog Used to Register Your ArcGIS Engine License and Obtain a License File 



24 

 

TargetTrack User's Guide 

 

Select the first option and the following screen will be displayed 
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Select the option you would like to use and then press the Next button. After pressing the Next 
button follow the instructions for the option you've selected. 

 Installing the License File 

After obtaining the license file you must then install it into the ArcGIS mapping software.  To install it 
go to the Start menu and select ArcGIS->Software Authorization to display the following 
dialog: 

  

Select the third option and press Next. 
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Figure 9: Authorizing a File Obtained by e-mail 



  27 

 

 Maps

 

Press Browse and navigate to the license file and press Next. 

 

The Authorization Complete dialog signifies the license was properly installed and now the ArcGIS 
Mapping Engine can be used in TargetTrack. 

 

 

Figure 10: Authorization Complete Will Display Dialog Above 
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ESRI ARCGIS MAPPING DISPLAY 

The figure below shows the ESRI mapping tool installed in TargetTrack.  The tool consists of a 
display pane and a tool bar containing a number of tools that can be used to open, save, build, and 
manipulate the maps. 

 
 

Figure 11: ESRI Mapping Tool Installed in SignalTrack 
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MAPPING TOOL BAR 

The graphic below illustrates the mapping tool bar. 

 

 The Open Map tool displays a standard open file dialog that displays ESRI mapping files that can 
be opened into the display. 

 The Save Map tool allows the user to save any changes that have been made to the map 
 The Layers drop down menu allows a user to enable and disable layers, add data (layers), and 

remove layers 
 The Select tool allows the user to manipulate standard elements such as sites. 
 The Zoom In tool allows the user to select a rectangle on the screen and the map will be 

zoomed to fit into the rectangle 
 The Zoom Out tool allows the user to zoom the map to a greater extent depending on the size 

of the rectangle selected 
 The Pan tool allows the user to pan the map display 
 The Zoom/Pan tool allows the user to zoom while panning (you have to try it to see how it 

works) 
 The Fixed Zoom In tool zooms the map a fixed amount 
 The Fixed Zoom Out tool zooms the map out a fixed amount 
 The Previous Extent tool allows the user to undo a map manipulation (e.g. zoom) 
 The Next Extent tool allows the user to redo a map manipulation (e.g. zoom) 
 Move to Location allows the user to input coordinates and the map will then automatically pan 

to these coordinates.  The coordinates can be entered in a number of formats including degrees-
minutes-seconds, decimal degrees, and MGRS 

 

Figure 12: ESRI Mapping Tool Bar 
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BUILDING MAP FILES 

TargetTrack uses ESRI map files (*.mxd) as the base map.  Data to make the map files is available 
from a variety of sources and TargetTrack can use this data to build ESRI map files. 

ESRI maps are built in layers.  Each layer of the map is built from standard map data files that use one 
of the following formats: 

 Shapefile data (*.shp)  
 Geodatabase data (feature classes, geometric networks, topologies, network datasets).  
 Raster data (Imagine Image (.img), Bitmap (.bmp), JPEG (.jpg, .jpeg), Portable Network Graphics 

(.png), Graphics Interchange Format(.gif), Tagged Image File Format (.tif, .tiff), Arc/Info & Space 
Imaging BIL (.bil), Arc/Info & Space Imaging BIP (.bip), Arc/Info & Space Imaging BSQ (.bsq), 
DTED Level 0-2 (.dted), ERDAS 7.5 LAN (.lan), ERDAS 7.5 GIS (.gis), JP2 (.jp2), MrSID (.sid), 
RAW (.raw), NTIF (.ntf), USGS Ascii DEM (.dem), X11 Pixmap (.xpm), PC Raster (.map), PCI 
Geomatics Database File (.pix), JPC (.jpc), J2C (.j2c), J2K (.j2k), HDF (.hdf), BSB (.kap), ER Mapper 
ECW (.ecw)).  

 Server data (ArcGIS Server, ArcIMS, WMS (Web Mapping Service) services)  
 Layer files (*.lyr) 

After the map layers are added TargetTrack can save the map as an ESRI map file (*.mxd).  
TargetTrack can then be used to open and manipulate (zoom, pan, etc.) the map files. 

To build map files from data, select Open Map from the TargetTrack File menu and navigate to the 
file Blank.mxd.  Next select Add Layers from the Layers menu.  The following dialog will be 
displayed. 
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Use this dialog to select the data you want to use to build the layers of your map.  Select the type of 
data you wish to add from the left window and then select the data in the main window. 

After you have built up the layers press the Save Map button on the mapping tool bar. 
 

MANIPULATING LAYERS 

Once you've loaded a map, individual layers can be disabled and enabled.  The Layers drop down 
menu lists all the layers in the order in which they are displayed.  The topmost layer is the first layer 
in the list; the next layer is listed second, etc.  A check box next to the layer name indicates that the 
layer is enabled and being displayed.  Many times layers above other layers obscure layers below 
them.  So, to see the lower layers you must disable the layers above the lower layers.  Merely 
enabling (checking) a layer may not display that layer if the layer above it obscures it. 

Layer can be removed by selecting the Remove Layer menu item from the Layers drop down 
menu.  When the dialog is displayed, check the layers you wish to remove and press OK. 

 

Figure 13: Select the type of Data to Add 
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TargetTrack is designed to interface the DDF6000 and DDF7000 series Doppler Systems' radio 
direction finders.  Interface to the DDF6000 series is via the computer serial port of via a serial to 
Ethernet converter.  Interface to the DDF7000 series direction finders is via an Ethernet connection.  
Direct connection to the Ethernet port from the computer requires a crossover cable.  See the MPT 
(DDF7000) User’s manual for further details. 
 

SETUP 

The following paragraphs describe the setup steps needed to operate TargetTrack. 
 

AUDIO 

TargetTrack requires an audio connection from the local direction finder to the computer.  For the 
6000 series direction finders this connection needs to be from the external speaker output of the 
direction finder to the left channel audio input of the computer.  This requires the computer have an 
audio line input and a cable that provides a 3.5 mm stereo plug connected to two 3.5 mm monaural 
inputs.  Adapters can be obtained from a variety of sources.  For the 7000 series audio can be 
connected either via the sound card similar to the 6000 series or via the Ethernet using the UDP 
audio streaming provided by the DDF7000. 
 

NETWORK NAME 

The first time you run TargetTrack you will be asked to enter a network name.  The network name 
is used by the database to keep track of the intercepts, intercept data, and recorded audio files.  The 
default name is the network name of the computer; however, you can select a different name if you 
would like to.  You can change this name later using Network Name in the File menu. 

 
 

RUNNING TARGETTRACK 

Figure 14: Enter the Direction Finding Network Name 
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LOADING MAP FILE 

After entering the network name the screen will look similar to the one below. 

 

 

Figure 15: Appearance of the Display at Startup 
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If it does not adjust the window splitters so you can view all the panes.  If you do not have a scan 
receiver connected close the scan receiver audio control by clicking the on the close button at the 
right of the control. 

If you are using maps generated by MapFix then from the Map menu select Open Map File...  In 
the resulting dialog select the map file you wish to use.  If you are connected to the Internet and wish 
to use Great Maps select New Great Map from the Map menu. 

The screen will then look similar to the one below. 

 
 

Figure 16: Display with a Map File Selected 
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AUTOMATIC IDENTIFICATION OF A DIRECTION FINDING SITE 

When MPT (DDF7000 series) direction finders are used in the system and all the direction finders 
are connected either by a crossover cable or to a local area network (LAN) TargetTrack will display 
the network parameters and location of the direction finder sites.  If the MPT's firmware version is 
2.13 or earlier then only the IP address and IP port of the direction finder will be display.  If the 
version is greater than 2.13 and a either the location has been entered into the MPT or the DF 
location has a GPS connected then the location of the site will be displayed. 

The display for the network data is in the lower right hand corner of the TargetTrack window as 
shown below. 

 

Figure 17: Direction Finders Installed on a LAN will be Displayed on this List 



  37 

 

 Chapter 3  Running TargetTrack

 

In the above example both direction finders are connected to a LAN.  The DF at 192.168.1.148 is 
running version 2.14 and the DF at 192.168.1.135 is running version 2.13. 

When the user moves the mouse over an unconnected DF site TargetTrack will display the location 
on the screen as shown in the example below. 

 

If the user wishes to connect to the site he simply right clicks on the network address of the site he 
wishes to connect and selects Connect as Fixed Site or Connect as Mobile Site as shown 
below. 

 

  

Figure 18: Placing the Mouse Over the Site Listed will Show the Location of the Site on the Map 
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Once the connection is made the network display will be updated to show the total number of 
connections to the direction finder.  If this instance of TargetTrack has made the connection then the 
number of connections will be displayed in bold as shown below. 

 

 
 

SETTING UP A DIRECTION FINDING SITE 

To setup a site, right click the mouse on the map near geographical location of the site.  Select the 
type of site you wish to set up either a fixed or mobile site.  The dialog box shown below will be 
displayed. 

 

Figure 19: Establish a Connection by Right Clicking on the List Item 

Figure 20: Connections to Each DF will be Displayed 

Figure 21: Enter the Site Name 
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Enter a site name and the color and size you would like to use for the site.  Then use the mouse and 
left click on the Direction Finder and Receiver topic to select the following dialog. 

 

Using the drop down combo boxes select the direction finder and the receiver you are using.  Set 
the site quality (Site quality is defined in the glossary).  Check GPS if a GPS receiver is connected,  
Radio Modem if you are using a radio modem to connect to other sites, and Compass if you have a 
compass connected to in your mobile configuration.  If the direction finder at the site requires a 
password check the Requires Password check box and enter a user id and password (see the MPT 
Software Users Guide) on how to set the direction finder to require a password). 

Next you can select the Geographical Location text to display the following dialog. 

 

Figure 22: Site Equipment Dialog 

Figure 23: Location Dialog 
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This dialog allows you to manually adjust the geographical location of the site.  If a GPS receiver is 
connected to the site then the location settings will be disabled because the position is determined 
by the GPS. 

Next press Connection to display the following dialog. 

 

Select 
the 
type of 

connect in the Connect Via drop down and set the connection parameters using the other drop 
downs.  

Press OK and a site will be displayed on the screen as shown below. 

 

If the site has an X through it then a connection to the site has not been made.  Check the physical 
cable connections to the direction finder and the connection settings.  You can edit the settings by 
right clicking on the site and selecting Edit Site from the pop up menu.  Holding the mouse over the 
site will display the status of the site. 
 

Figure 24: Connection Dialog 

Figure 25: Appearance of a Fixed Site on the Map 
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USING TARGETTRACK WITH A NAT ENABLED ROUTER 

TargetTrack requires audio from the primary site in order to operate properly.  If you are using a 
DDF7000 series direction finder, the direction finder streams UDP audio from the Ethernet 
connection.  If your computer is connected to a NAT enabled router and the direction finder is 
outside of your local area network (LAN) then you must configure your router and TargetTrack to 
receive the audio.  An example of this would be a DDF7001 direction finder that is connected to the 
Internet and a computer running TargetTrack that is connected to a modem/router. 

Note: Some Internet providers block access to certain ports.  If this is the case try using IP port 80 for audio 
streaming.  If this does not work contact your provider to determine what port to use. 
 

CONFIGURING YOUR ROUTER FOR AUDIO STREAMING 

To configure you router you must port forward the audio port that you will receive the audio UDP 
stream to the local IP address of your computer.  To determine your computers IP address open a 
command prompt and type ipconfig.   A display similar to the one below will appear 

 

The IPv4 address of the adapter is the IP address that you want to port forward the UDP audio to.  
Typically this address will be 192.16x.xxx.xxx. 

Once you've determined this address then you need to set up the port forwarding in you router, 
forwarding the audio IP port (default value is 10001) to the IP address you obtained above.  A typical 
entry in a port forwarding table is shown below. 

  

Figure 26: Determining the IP Address of the Hose Computer 
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CONFIGURING TARGETTRACK TO STREAM AUDIO FROM AND EXTERNAL IP CONNECTION 

When using a DDF7000 series direction finder outside of a local area network (LAN) streaming 
audio to TargetTrack requires that the direction finder must know your external IP address.  The 
external address is the address that external IP connections such as web sites use to send 
information to your router.  Your router then translates the external IP address into an internal IP 
address using the NAT in the router and sends the information to your computer. 

When setting up a site TargetTrack will attempt to determine the external IP address.  This address 
will be displayed in the communications dialog box similar to the one shown below. 

 

If the Incoming Audio IP Address is blank or if you know this address is not your external IP address 
then you must enter the external IP address in the test box.  In most cases, if an address is displayed 
it will be the one to use. 

If there is no address displayed then you will need to determine it.  Contact your network 
administrator or log on to your router to find this address. 
 

Figure 27: Typical Port Forwarding Router Entry 

Figure 28: Incoming Audio IP Address 
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COMPASS 

If you are using a compass in a mobile configuration, it is important to properly install the compass 
and then calibrate it in its installed environment.  The compass must be installed well away from any 
ferrous metal sources (steel or iron).  If mounting on a steel roof, a non-ferrous (aluminum, wood, 
plastic, etc.) spacer is required to maintain at least a 3-inch spacing from the roof.   

After mounting the compass, it must be calibrated to its magnetic environment.  To perform this 
calibration, right click on the mobile site as displayed on the map to display the following menu. 

 

Figure 29: Select Calibrate Compass to start the compass calibration 
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Select Compass Calibration and then click Start. 

 

The dialog below will be displayed.  Point the vehicle in a northerly direction and then press Next.  It 
is not necessary to be exactly north.   

 

Then point the vehicle north-east and press Next. 

 

Continue this process until you have completed a full 360 degree calibration.  At the end of the 
calibration, a calibration quality dialog will be displayed with a Noise Score and a Magnetic 
Environment reading. 
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The Noise Score value is an indication of the quality of the of the data collected. The score will be a 
number in the range 0 to 9, 0 being the worst and 9 the best. If the score is 6 or below, re-
calibration is recommended for optimum accuracy. 

The magnetic environment count gives an indication of the quality of the magnetic environment, with 
9 being the best and 0 the worst. If the value is less than 5, you should consider relocating and re-
calibrating the compass in a better environment (i.e. away from magnetic fields and material). 

Noise 

Score 

Approximate 

Accuracy 

9 .5° or better 

8 1° or better 

7 2° or better 

6 4° or better 

5 8° or better 

4 16° or better 

3 32° or better 

2 64° or better 

1 128° or better 

0 256° or better 

 

AUDIO SOURCE 

If you are using a MPT (DDF7000) direction finder then you next select the audio source from the 
Audio Source menu.  If the audio is connected via the sound card select sound card.  If you are 
streaming audio from the direction finder then select the site name from the Audio Source menu.  
Once selected, audio received by the direction finder will be streamed to TargetTrack. 

 
 

SCAN RECEIVER 

TargetTrack has provisions to control and monitor a second receiver.  The scan receiver can be an 
ICOM R8500, ICOM R2500, AOR AR8600, AOR AR5000, or an AOR AR5001D receiver.  To 
control the receiver the receiver must be connected to the PC using a USB or serial connection.  
The audio from the receiver must be connected to the right channel of the line input to the PC.  If 
you are not using a scan receiver close the scan receiver audio control by clicking the close box 
located on the right side of the control. 
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SUMMARY 

At this point you are now ready to operate the site.  If you have additional sites that are connected 
via an Ethernet connection you can add them at this time using the procedure outlined above. 
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SCREEN LAYOUT 

The figure below shows the major areas of the screen 

 

Figure 30: Target Track Display 
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Map 

The Map displays the location of the sites and the bearings as they are received.  Placing the mouse 
over a site will display the status of the site.  A site with an X through it indicates that it is not 
operational. 

Audio Controls 

The Audio Controls display and control the incoming audio.  The operation of the audio controls is 
explained in the Audio Controls section. 

Receiver Controls 

The receiver controls are used to set the frequency, volume, and squelch of the DF receiver and the 
scan receiver.  It is also used to set up the scan banks for the receiver if scanning is desired. 

Bearing Display 

The bearing display shows the bearings that are measured during the intercept.  The highlighted 
bearings indicate the bearings being displayed on the screen. Right clicking in the header of this 
display will allow you to select which columns you want to display. 

Frequency Display 

The frequency display shows the frequencies on which signals have been received.  Double clicking 
on one of these frequencies will tune the active receiver to that frequency.  Right clicking in the 
header of this display will allow you to select which columns you want to display. 

Intercept Display 

The intercept display shows the intercepts that have been received.  Each intercept has an up time, a 
down time, and a frequency.  Double clicking on the intercept will cause it to playback.  Right clicking 
on it will allow you to select the Edit Transcript function which is discussed in the Data section of 
this document or to delete the intercept. Right clicking in the header of this display will allow you to 
select which columns you want to display. 

Target Display 

A list of targets for the currently displayed intercept.  Right clicking in the header of this display will 
allow you to select which columns you want to display. 

Radio Modem Menu 

Menu to setup and operate a radio modem connection. 
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AUDIO CONTROLS 

The audio controls are very important in monitoring and operating TargetTrack.  This section will 
discuss the operation of the audio controls.  The Audio Control consists of a number of sub 
controls.  The function of each of these controls is explained below.  There are one set of controls 
for the left channel and one set of controls for the right channel.  The figure below shows these 
controls and their function is explained in the following paragraphs. 

 
 

AUDIO FILE CONTROL 

The Audio File Control  and its operation are explained in this section. 

A screen shot of the control is shown below.  There are identical controls for the direction finder 
and the scan receiver. 

 

Figure 31: TargetTrack Audio Control 

Figure 32: Audio File Control 
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Green rectangles indicate previously recorded files.  Blue rectangles indicate a file that is currently 
being recorded. 
 

OPERATION 

The Figure below illustrates the Audio File Control.  The control consists of a Tool strip with 
buttons, two labels, and a display panel.  The width of the panel represents a time span.  The middle 
of the panel represents the Set Time that is marked by a yellow line. 

 

The Set Time can be increased or decreased and any time. If the set time is decreased the displayed 
files will move to the left.  If the set time is incrementally increased, the displayed files will move the 
right and any new files that come into the time span will be shown to the far left of the control.  
When the set time is incremented and a file's start time is less than or equal to the set time the 
control will start playing and the associated bearings will be displayed.  If after incrementing the set 
time, the time at the end of the file is less than the set time then the control will stop playing. 
 

SELECTION MODES 

The Audio File Control has four selection modes: Normal, Zoom In, Zoom Out, and Pan.  The 
selection mode determines the interaction of the control with the mouse.  The following paragraphs 
explain the way the control will work in the various modes.  Mode selection is done using the 
controls on the tool strip at the top of the panel display. 
 

Figure 33: Set Time Indicator 
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NORMAL MODE 

In the normal mode  the cursor is the default cursor.   

No Mouse Button Pressed 

When moving the cursor across the panel with no mouse button pressed, a tool tip appears at the 
cursor location when the cursor points to a file.  The tool tip displays the file's name. 

Left Mouse Button 

When the left mouse button is pressed and the mouse is dragged a selection rectangle appears and 
increases or decreases in dimension with the mouse motion.  When the left button is released the 
selection rectangle remains. 

Right Mouse Button 

When the right mouse button is pressed and the mouse is over a region that represents a file, the 
Normal context menu appears. 

When the right mouse button is pressed and the mouse is within a previously drawn selection 
rectangle, the Selection context menu shall be displayed. 

Left Mouse Button Double Click 

If the user double clicks the left mouse button and the mouse position is greater than 5 pixels from 
the center line, the set time will be changed to the time represented by the point where the mouse 
was positioned. 
 

ZOOM IN MODE 

When in the zoom in mode  the cursor changes to the zoom in cursor when the mouse 
positioned over the display panel. 

Left Mouse Button Down 

When the left mouse button is pressed a selection rectangle is displayed and expands and contracts 
with the motion of the mouse.  When the left mouse button is released the time span of the control 
is changed to the time span represented by the selection rectangle and the set time is changed to the 
value represented by the center of the selection rectangle. 

Double Click 

When the left mouse button is double clicked on the control, the time span is changed to half of the 
current time span. 
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ZOOM OUT MODE 

When in the zoom out mode  the cursor changes to the zoom out cursor when the mouse 
positioned over the display panel. 

Left Mouse Button Down 

When the left mouse button is pressed a selection rectangle is displayed and expands and contracts 
with the motion of the mouse.  When the left mouse button is released the set time is changed to 
the value represented by the center of the selection rectangle and the time span is changed by a 
factor of Tspan/Tsr where Tspan is the current time span and Tsr is the time represented by the 
width of the selection rectangle.  

Double Click 

When the left mouse button is double clicked on the control, the time span is changed to twice the 
current time span. 
 

PAN 

When in the Pan mode  the cursor changes to the Pan cursor. 

Left Mouse Button Down 

Pressing the left mouse and dragging the mouse causes the set time to change to scroll the file display 
to follow the mouse. 
 

CONTROLS 

The Audio File Control contains a number of .Net controls.  The figure below illustrates the controls 
and the following paragraphs describe the operation of these controls. 

 
 

Figure 34: Audio File Control Tools 
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NORMAL CURSOR BUTTON 

 When the Normal Cursor Button is pressed the audio file control is put into the normal 
selection mode.  
 

ZOOMIN BUTTON 

 When the Zoom In button is pressed the audio file control will be placed in the Zoom In 
selection mode. 
 

ZOOM OUT BUTTON 

 When the Zoom Out button is pressed the audio file control will be placed in the Zoom Out 
selection mode. 
 

PAN BUTTON 

 When the pan button is pressed the audio file control is placed in the Pan selection mode. 
 

FILE NAME LABEL 

 The filename label displays the name of the file that is currently playing.  If there is no file playing 
then the file name will be blank.  
 

SET TIME TEXTBOX 

 The Set Time Textbox will display the Set Time of the audio file control and allow the user to 
enter the set date and time.  If the date of the Set Time is the same as the current date then the date 
field (dd/mm/yy) will not be displayed.  Right clicking on the Set Time Textbox will cause a calendar 
popup menu to be displayed allowing the user to easily set the date.  When the Audio Control is in 
the play mode the Set Time Textbox will display the time of play and therefore, will be incrementing 
in 0.5 second increments. 
 

CONTEXT MENUS 

The audio file control will have two context (pop up) menus: the normal context menu and the 
selection context menu. 
 

NORMAL CONTEXT MENU 
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The normal context menu has four items in it.  When the user right clicks in the control this menu 
appears.  If the user clicks on a file representing, the Play File, Edit Transcript, and Delete 
Intercept items are shown.  If the user right clicks on a point where there is no file represented, 
only the Set Time item will be shown. 

Set Time 

If the user selects Set Time, the time represented by the location where the user clicked will be 
the new set time. 

Play File 

If the user selects Play File then the file that was clicked on will begin to play from the beginning. 

Edit Transcript 

If the user selects Edit Transcript then the database transcript will be displayed for editing. 

Delete Intercept 

If the user selects Delete Intercept then the intercept will be deleted and its representation on the 
audio display removed. 

Add Intercept to Transcript 

If the transcript editor is displayed and it is displaying a transcript of an intercept or intercepts that is 
different than the intercept that was right clicked on then the Add Intercept to Transcript menu 
item is displayed.  Selecting this item will add the intercept to the displayed transcript.  See Grouping 
Intercepts for more information on assigning a single transcript to multiple intercepts. 

 

 
 

SELECTION CONTEXT MENU 
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The Selection context menu will be displayed when the user right clicks on a selection. 

Save Selection 

If the user selects Save Selection, the software will determine if a one or more files or portions of 
one or more files have been selected.  If a valid selection has been made a Save File dialog will be 
displayed allowing the user to enter a file name for the file.  Once a file name is selected the software 
saves the selected portions of files to the filename entered by the user. 

Play Selection 

If the user selects Play Selection, the software will set the Set Time to the right side of the 
selection box and play the file until the time exceeds the left side of the selection box. 

Loop Selection 

If the user selects Loop Selection, the software loop the audio from the beginning of the selection 
to the end of the selection.  Looping can be halted by right clicking anywhere on the audio file 
control and selecting Stop Looping. 

Zoom Selection 

If the user selects Zoom Selection the Time Span of the control is expanded to be the same width as 
the selection box.  The Set Time shall be adjusted so that it is in the middle of the zoomed selection. 
 

FULL REWIND BUTTON 

 When this button is pushed the Set Time of the Audio File Control is changed to the current 
time - 60 minutes. 
 

REWIND BUTTON 

 When this button is pushed the Set Time of the Audio File Control is decremented by 500 ms.  
Holding down on this button will cause the time to be continuously decremented in 500 ms 
increments. 

 
 

HOLD/PLAY BUTTON 

  If the control is in the hold mode pressing this button transitions the control to the play mode.  
If in the play mode pressing this button transitions the control to the hold mode. The icon on the 
button will change between the pause and play icon. 
 

FAST FORWARD BUTTON 

  Pressing this button increments the Set Time of the Audio File Control by 500 ms.  Holding 
down this button will continuously increment the Set Time in 500 ms increments. 
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FULL FORWARD 

 Pressing this button changes the Set Time of the Audio File Control to the current time. 
 

RECORD HOLD TIME 

 This slider controls the time that the channel keeps recording after the volume is lower than 
the squelch level.  The time delay is adjustable from 2 to 40 seconds.  The audio level must be below 
the squelch level for the entire record hold time.  If the audio level exceeds the squelch level at any 
time during the record hold time then the hold time period is reset. 
 

SQUELCH CONTROL 

 This slider is used to set the level of audio that will trigger recording to start in a given channel. 
 

VOLUME CONTROL 

 This slider is used to control the volume in the left or right channel. 
 

MUTE/UNMUTE 

  This button is used to mute or listen the channel it is assigned to.  When muted the control 
shall display as shown below.  When unmuted the control shall display as shown below. 

 Muted 

Listen 
 

SYNCHRONIZE 

 This button is used to synchronize the direction finder audio file control with the receiver audio 
file control.  When the button is pressed the set time and time span of the controls will be identical.  
When panning or zooming whichever control is panned or zoom the other control will follow. 

  Synchronized 

 Not Synchronized 
 

VU METER 

 The VU meter displays the level of the audio that is playing. 
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START/STOP RECORDING 

The Start/Stop Recording button enables or disables audio and bearing recording.  When Start 
Recording is pressed, the audio is recorded on the direction finder and scan receiver channels.  The 
bearing data is also recorded and at the end of the intercept the audio and bearing data are stored in 
the database.  When the Stop Recorder is pressed all recording of audio and bearing data is disabled. 
 

HIDING THE SCAN RECEIVER AUDIO CONTROL 

Pressing the x in the upper right hand corner of the Scan Receiver Audio Control (bottom audio 
control) will hide the control and disable the Scan Receiver function.  The scan receiver function can 
be re-enabled by selecting Show Scan Receiver from the View menu. 
 

RECEIVER CONTROLS 

A screen shot of the receiver controls is shown below.  The Direction Finder tab controls the 
primary site direction finder receiver and the Scan Receiver tab controls the scan receiver.   

 

Figure 35: Receiver Control 
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The volume, squelch and frequency knobs can be controlled by clicking on them or using the up and 
down arrow keys.  Right clicking on the knobs causes the setting to increase and left clicking causes 
the value to decrease.  Similarly selecting the control and then pressing the up arrow key increases 
the setting and pressing the down arrow key decreases the setting. 

Pressing the Scan button in the menu bar toggles the menu bar between Scan and Search 

When the scan receiver is selected an additional menu item, Setup, is displayed allowing the user to 
select the type of receiver to be used and the port the receiver is connected to.  The figures below 
illustrate the scan receiver display. 

 

 

Once the scan receiver is properly setup and connected it can be tuned and scan bank frequencies 
can be entered in the same fashion as the direction finder receiver.  The audio files for the scan 
receiver will be shown on the lower audio control. 
 

Figure 36: Scan Receiver Connection 



  59 

 

 Running TargetTrack

 

SCANNING 

If the Scan/Search button in the menu is set the Search press it to toggle it to Scan.  Then to start a 
scan select the Scan Bank from the drop down and press Start. 

To edit the scan bank memories press Edit and the following dialog box will be displayed.  Pressing 
the upload button will upload frequencies already loaded into the receiver memory.  If the user 
changes a memory it will be highlighted in fuchsia.  Pressing the Download button will download it 
into the receiver memory.  Each bank is treated separately and can be selected using the Bank drop 
down.  The frequencies to program into the memory can be read from a .csv formatted file. 

 

Figure 37: Scanning Dialog 
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The file needs to have the following format. 

Receiver Memory Frequencies         

 Bank0 Name Bank1 Name Bank2 Name Bank3 Name Bank4 Name 

Channel 0 154.19 15K9 0  0  0  0  

Channel 1 145.25  0  0  0  0  

Channel 2 146.56  0  0  0  0  

Channel 3 146.58  0  0  0  0  

Channel 4 123.5  0  0  0  0  

Channel 5 146.6  0  0  0  0  

Channel 6 146.62  0  0  0  0  

Channel 7 146.64  0  0  0  0  

Channel 8 146.66  0  0  0  0  

Channel 9 146.68  0  0  0  0  

Channel 10 146.7  0  0  0  0  

Channel 11 146.72  0  0  0  0  

Channel 12 146.74  0  0  0  0  
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SEARCHING 

If the Scan/Search button in the menu is set the Scan press it to toggle it to Search.  Then to start a 
search select the search Bank from the drop down and press Start. 

 

To edit the search bank memories press Edit and the following dialog box will be displayed. 

 

Figure 38: Selecting the Search Function 

Figure 39: Search Function Dialog 
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If the text is in blue then this search bank has not been entered as a search bank in the receiver. To 
download the search bank frequencies simply enter the lower and upper limits, the step size and a 
name of the search bank and press set.   If the text is black then the search bank frequencies are valid 
as shown below. You can change them by typing in new values and pressing set. 

 

On 
the 

right of the display are pass frequencies. 

Pass frequencies may be entered by typing in the frequency and pressing the Add button.  They can 
be removed by right clicking on the pass frequency list and selecting Remove or Remove All. 
Remove will remove the selected items, Remove All will delete all the pass frequencies. 

During a search, a pass frequency can be added by pressing the pass button in the receiver control as 
shown below. 

 

Figure 40: Pass Frequencies 
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USING THE 
CONTOUR 

SHUTTLEXPRESS TO TUNE THE RECEIVER 

The Contour ShuttleXPress is a device that can be used in TargetTrack to control the direction 
finder receiver and the scan receiver.  This section will explain the use of this control to control the 
receivers. 

A photo of the ShuttleXPress is shown below.  The controls' operation is described below. 

 

Figure 41: Pass Frequency Button for Search 

Figure 42: Contour Shuttle Express 
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 Start Recording.  This button will cause TargetTrack to start recording the audio and bearing 
data. 

 Stop Recording.  This button will cause TargetTrack to stop recording the audio and bearing 
data. 

 Decrement Frequency.  Pressing this button will cause the displayed receiver frequency to 
decrease by one tuning step. 

 Increment Frequency.  Pressing this button will cause the displayed receiver frequency to 
increase by one tuning step. 

 Synchronize Frequencies.  If the DF receiver tab is active pressing this button will cause the scan 
receiver to be tuned to the DF receiver frequency.  If the scan receiver is active pressing this button 
will cause the DF receiver to be tuned to the scan receiver frequency. 

 Jog Frequency.  Rotating this control one step clockwise and holding it in this position will cause 
the frequency to increase slowly.  Rotating further clockwise will cause the frequency to increase 
more rapidly.  Rotating the control counter clockwise decreases the frequency in the same way. 

 Tune Frequency.  Rotating this control clockwise will increase the frequency and rotating it 
clockwise will decrease the frequency.  This control operates similarly to the dial on the front of 
many general purpose communications receivers. 

 
 

MAP CONTROLS 

The map contains various controls to manipulate the map and the set the type of location display 
desired by the user.  A screen shot of the map controls is shown below. 
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The zoom controls allow the user to zoom in and zoom out.   

Click on the move tool to enable repositioning of fixed, virtual, and beacon sites on the screen. 

The display tool will show a drop down menu allowing the user to select the format to use to display 
locations on the map. 

 
 
 
 
 

 
 
 
 
 
 

ADDING PLACEMARKS 

When using Great Maps the user has the ability to add placemarks to the map.  To add a placemark, 
first make sure the Show Placemarks item in the Map menu is checked as shown below. 

 

Figure 43: Map Display Menu 
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Next right click on the map where you would like to add the placemark.  Select Add Placemark 
from the drop down context menu and select the icon image you would like to use for the 
placemark as shown below. 

 

 

A dialog will be shown allowing you to name the placemark.  You can also type in the position if you 
would like.  If you want to move the placemark after you enter it on the map you can either type in 
the coordinates or you can use the site move tool on the Map Controls. 

A set of default placemark icons are furnished with TargetTrack.  However, you can add to this list 
by putting image files in My Documents\\Doppler Systems\\TargetTrack\\Placemarks.  If this directory 
exists all the image files in this directory will be displayed on the Add Placemark menu. 
 

IMPORTING PLACEMARKS 

You can import placemarks from a file exported by another TargetTrack user or from a .gpx file.  To 
do this make sure the Show Placemarks item is checked in the Map menu.  Then, as shown below, 
select Placemarks->Import Placemarks. 

 

A file selection dialog will be displayed and you then select the file you wish to import the placemarks 
from. 
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MODIFYING AND REMOVING PLACEMARKS 

To modify the display of the placemarks or to delete them right click on the placemark and select the 
desired action form the pop up menu. 

 
 

MEASURING DISTANCES 

To measure distance on the map, right click anywhere on the map and select Calculate Distance. 

 

The following dialog will be displayed 
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When this dialog is displayed, left click on the starting location and then press the shift key and left 
click again.  The distance will be displayed in the dialog. 

 

This feature only works with Great Maps. 
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FREQUENCY DISPLAY 

The frequency display shows all the frequencies that have been received by the scan and direction 
finding receivers.  These frequencies persist from session to session so that the frequencies are 
readily available to allow the user to easily tune to these saved frequencies.  The Frequency Display 
works in conjunction with the Receiver controls.  When a receiver is activated (tab selected) then 
double clicking on an entry in the Frequency display will tune the receiver to that frequency.  
Additionally there is a pop up menu that allows the user to tune either receiver to the selected 
frequency, to delete the frequency from the list or to add the frequency to a scan bank. 

 
 

Figure 44: Adding a Frequency to a Scan Bank 
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TARGET DISPLAY 

The Target display shows information about the targets that TargetTrack has identified or have been 
identified by the user using the manual target feature.  A sample display is shown below along with 
the corresponding map display.  As shown in the figure there are four targets displayed on the map.  
The location column shows the predicted location of the target.  This can be in MGRS or latitude 
and longitude depending on the map settings.  The CEP displays the circular ellipse probability.  This 
the diameter of an equivalent circle that around the target.  Under ideal conditions that target will 
have a 95% probability of being within the CEP.  The time column displays the last time the target 
was updated.  The most current target is designated as the active target and the active check box is 
checked for this target.  If the user clicks on a target the average bearings that are being used to 
calculate the target location are displayed in the Average Bearings table at the bottom of the target 
display. 

The user can delete a single target by right clicking on the target and selecting delete.  All targets can 
be deleted by pressing the Delete All button. 

 
 

Figure 45: Typical Target Display 
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OPERATION WITH A RADIO MODEM 

TargetTrack is designed to connect with remote sites and mobile sites using a radio modem.  The 
radio modem we recommend is the Cal Amp DataRadio Integra-TR.  The radio modem can be 
connected to the system via a serial port on the computer or if you are using a MPT (Series 7000) 
direction finder you can connected to a USB-to-serial converter that is connected to the MPT 
processor.   

When networking using radio modems a site can be either a master or a slave.  The master is 
typically a control site and controls the frequency of the direction finding network.  It polls for slave 
connections and relays the collected data to all slaves.  This site should have clear line-of-site 
communications with all the slaves if possible. 

A slave site responds to commands and polling by the master.  Typically a slave will be a mobile site 
or a remote fixed site with or without a computer. 
 

OPERATION AS A MASTER 

To operate the site as a master you must first press the Master button in the Radio Modem menu 
bar, select the serial port that the radio modem is connected to.  The menu for this selection is 
shown below 

              

If you 
are 
using 
an MPT 

direction finder the MPT user interface software is used to configure the serial ports to use the radio 
modem and the MPT port available for the radio modem will be displayed.  If the radio modem is 
connected to the computer's serial port then you would select that port. 

To start the connection press the Connect button in the radio modem menu strip and the software 
will start to poll looking for slave connections. 
 

OPERATION AS A SLAVE 

To setup TargetTrack as a slave, first press the Slave button in the radio modem menu strip.  Next 
select the type of connection and enter a network ID.  The menu items are shown below 

 

Figure 46: Radio Modem Serial Port Selection 

Figure 47: Network ID Setting 
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After making these settings press the Connect button and TargetTrack will begin monitoring for a 
poll from the master site. 
 

RADIO MODEM INDICATORS 

The radio modem indicators are shown below.  When the Connected indicator is amber it indicates 
that a serial port connection has been opened to the radio modem serial port.  When TargetTrack is 
in the master mode and the Connected indicator is green it indicates that a connection has been 
made with a remote (mobile) site.  When TargetTrack is in the slave mode a green Connected 
indicator indicates that the remote has is receiving poll messages from the master.  When the 
Connected indicator is red it indicates that an error has been detected.  Double clicking on the 
Connected indicator will display the error message.   

The Transmit and Receive indicators are amber when in the radio modem is waiting to transmit or 
receive.  The Transmit indicator flashes green when TargetTrack sends a message and the Receive 
indicator flashes green when TargetTrack receives a message from the radio modem. 

 

 

 

 

 

Figure 48: Radio Modem Indicators 
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MENU FUNCTIONS 

The following paragraphs discuss the function of the menus in the main menu bar. 
 

FILE 

 

The File menu allows the user to define missions.  Missions are simply saved files that define the 
location and connection of sites.  In most cases users will not need to save missions because 
TargetTrack always saves the current mission and restores it upon restart.  However, it may be 
advantageous to save a mission in case of a computer malfunction or an operator error that would 
affect the operation of the software. 

The Network Name item allow the user to change the network name which is used by the 
database to organize the data by the particular computer it is recorded on.  If it is desired that data 
be moved from one computer to another it is best to have each computer have a unique network 
name. 
 

VIEW 

 

Figure 49: File Menu 

Figure 50: View Menu 
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The View menu determines what is displayed on the map.   

Unchecking the Show Bearings item will cause software to not display the lines of bearing from the 
sites. 

Unchecking the Show Estimated Target Location item will cause the software to not display the 
instantaneous target estimates 

Unchecking the Show Average Estimated Target Location will cause the software not to 
display the average estimated location on the Map 

Unchecking the Show Target Probability Ellipse will cause the software to not display the 95% 
probability ellipse. 

Unchecking the Show Scan Receiver item will cause the Scan Receiver audio control to be hidden 
and the scan receiver function to be disabled.  Checking it will re-enable the scan receiver function. 

Bearing Timeout allows the user to enter a timeout period so that if a site does not receive a 
bearing in this timeout period the bearing is not displayed. 

Show List of Sites will display a list of the active sites and their status.  A sample is shown below 

 

Checking the Delete box and pressing OK will delete the sites.  
 

DATA 

 

Figure 51: Active Sites Dialog 

Figure 52: Data Menu 
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Selecting Search causes the Search dialog to be displayed as discussed earlier. 

Selecting Import allows a user to import data that was recorded by TargetTrack on a different 
computer. 

Selecting Repair Database will rebuild the database using the data in the MP3 headers of the audio 
file. 
 

TARGET 

 

The Target menu allows the user to set parameters for display of the target. 

Estimate Size determines the size of the estimates displayed on the map. 

Estimate Color determines the color of the instantaneous estimates 

Average Target Estimate allows the user to set the display properties of the averaged bearings 
and target estimates. 

 

Bearing Color sets the color of the averaged bearing 

Estimate Color sets the color of the average estimate. 

CEP Threshold Color sets the color of the average estimate and the average estimate ellipse 
when the CEP is less than a set value.  When the CEP is less than the CEP Threshold the color of the 
average estimate and the ellipse change and the target is highlighted in the target display. 

Figure 53: Target Menu 

Figure 54: Average Target Estimate Menu 
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Estimate Ellipse determines how the estimate ellipse is displayed.  It can be displayed as an ellipse 
or as a heat map. 

Number of Averages determines the number of averages used to determine the average 
estimated position of the target. 

CEP Threshold allows that user to set a value for the CEP threshold.  If this threshold is crossed 
TargetTrack indicates this by displaying the average estimate and the estimate ellipse in a different 
color and highlighting the target in the Target Display window. 

Hold Targets Between Intercepts.  Select this option if you want TargetTrack to keep the 
calculated targets on the screen when a new intercept starts.  If this option is unchecked all old 
targets will be deleted when a new intercept begins. 

Manual Targeting enables the manual targeting option.  If Manual Targeting is unchecked then 
TargetTrack will automatically identify targets. See the targeting topic for more information. 

 

WINDOWS 

 

The Windows menu allows the user to hide and show any of the displays on the desktop.  The 
displays can also be hidden by pressing the close box in the upper right hand corner of the displays.  
 

  

Figure 55: Windows menu 
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AUDIO SOURCE 

 

The Audio Source menu allows the user to select where the audio comes from.  This is only 
applicable to the Direction Finder if the Direction finder is a MPT (DDF7000 series).  The scanning 
receiver will always be set to the sound card. 
 

SITE CONTEXT MENUS 

Right clicking on a site will display a menu that allows you to change the site display, disable the site, 
change the site quality, change the DF settings of the site, edit site, or delete the site.  A screen shot 
of the site context menu for a fixed or mobile site is shown below. 

 

Figure 56: Audio Source Menu 

Figure 57: Site Context Menu 



80 

 

TargetTrack User's Guide 

 

Disable 

Selecting Disable will cause TargetTrack to ignore the bearings from this site.  The bearings will not 
be displayed and will not be used in the target estimation. 

Color 

Selecting Color will display a color menu allowing the user to select the color of the site and its 
bearing lines 

Size 

Selecting Size will display a drop down menu allowing the user to select the size of the site on the 
map. 

DF Settings 

Selecting DF Settings will display a drop down menu that allows the user to change the settings of 
the direction finder.  This is discussed more fully in the direction finder settings section. 

Edit Site 

Selecting Edit Site will display the same dialog used to set up the site originally. 

Delete Site 

Selecting Delete Site will prompt the user to confirm the deletion of a site. 
 

DIRECTION FINDER SETTINGS 

Typically the default settings of the direction finder are adequate under most conditions.  However, 
in some instances it is necessary to change the settings.  TargetTrack allows the user to change the 
settings as needed.  The change the settings right click on the direction finding site and select DF 
Settings.  The pop up menu shown below will be displayed. 

 

Figure 58: DF Settings Menu 
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Averages 

Selecting Averages will allow the user to select the number of averages used by the direction finder 
to calculate the bearing.  Typically a setting of 2 is best. 

Sweep Rate 

Selecting Sweep Rate allows the user to select the speed of synthetic rotation of the antenna.  The 
default value of this is 1000 Hz, and this value works well.  However, if you are direction finding on a 
digital signal with significant 1000 Hz content it may be necessary to set the sweep rate to a different 
value to obtain a stable bearing. 

Attenuator 

Selecting Attenuator will turn on or turn off the attenuator in the antenna.  This is sometimes 
useful in mobile applications when strong signals can saturate the front end of the receiver. 

More 

Selecting More will display a dialog similar to the one below. 

 

Figure 59: DF Settings Dialog 
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Averages, Sweep, and Attenuator are all as discussed above.   

Threshold 

The direction finder has an algorithm that requires consecutive bearing samples to be within a certain 
window.  The width of this window is defined by the threshold setting.  The function of this setting is 
to prevent the direction finder from calculating a bearing on noise when the squelch breaks and 
there is no signal.  Increasing this setting will cause the direction finder to calculate more bearings on 
false signals.  Decreasing the setting will require a stronger signal in order to calculate the bearing.  A 
more detailed discussion of this topic can be found in the Application Notes 
http://www.dopsys.com/appnotes/RF%20Sensitivity%20of%20Series%207000%20(MPT)%20DF.
pdf section of our website. 

Defaults 

Pressing the Defaults button will reset the direction finder settings to their default values.  If the 
user presses this recalibration of the sites may be required. 

Reset 

Pressing Reset resets the processor.  During the reset the communications with the processor will 
be lost.  The software will attempt to reestablish communications. 

Volume 

Volume sets the speaker/headphone volume of the direction finder. 

Level 

Level sets the audio level of the receiver.  To set this level tune the receiver to a frequency with a 
signal and adjust this level until the VU meter displays slightly in the red. 

Cal Bearing 

The Cal Bearing button allows the user to calibrate the bearing to some value.  Calibration using 
the beacon method is preferable. 

Cal Sig = 9 and Cal Sig = 0 

These buttons are used to calibrate the s meter settings for receivers that have an analog RSSI 
output.  To set these first disconnect the antenna from the direction finder and open the receiver 
squelch.  Press Cal Sig = 0.  Next connect the antenna and tune in a signal that has an S9 level and 
press Cal Sig = 9.  This signal is best supplied by a signal generator. 

Antenna 

Selecting Antenna allows the user to switch antennas.  In the fixed site antenna the antenna is 
automatically switched when the frequency is changed so no adjustment of this setting is normally 
required. 
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TARGET LOCATION ESTIMATION 

By using multiple networked locations TargetTrack can estimate the location of the radio frequency 
emitter (target).  A location estimate algorithm is used that provides a least squares estimate of the 
location of the target and a calculation of the 95% ellipse.  The 95% ellipse indicates that under ideal 
conditions the target has a 95% chance of being within that ellipse.  The algorithm uses all sites that 
are collecting data to provide the estimate. 

Manual Target Estimation 

Under the Target menu the user may select the Manual option.  When this option is selected the 
user determines which bearings to use to estimate the target.  At the top of the Target display a 
New button will appear when a signal is present.  Upon examining the bearings the user can press 
the New button to enable a new target.  TargetTrack will take the currently displayed bearings and 
estimate the target location.   To add to the estimate the user then must click Active the check box. 

 

The display below shows two targets.  If upon observing the display the user thinks that the bearings 
currently being measured would enhance the estimate of either target then he would check the 
active check box next to that target.  If the currently measured bearings would result in an entirely 
new target he would press the New button to establish a new target on the screen on in the Target 
display. 

 

Figure 60: Manual Target Display 

Figure 61: Selection of Manual Target 
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Automatic Estimation 

If Manual Targeting in the Targeting menu is unchecked the software will attempt to identify 
targets based on the measured bearings.  After a target is first established based on measured 
bearings the software compares the next set of measured bearings to determine if the estimated 
target is within the target ellipse.  If it is outside of the ellipse then the target estimator identifies it as 
a different target. 
 

INTERCEPT DATABASE 

The intercept database is a searchable database that contains links to each recorded audio file and its 
associated data.  This data is stored on the computer in a user directory known by the database.  In 
addition to the data collected by the software the user can also enter descriptive data on the 
intercept to help identify the target.  This user entered data is referred to as the transcript.  A 
transcript can be related to several intercepts by using the grouping function. 
 

SEARCHING THE DATABASE 

Selecting Search from the Data menu will display the following dialog. 

 

Figure 62: Intercept Database Search Dialog 
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The user can enter in any of the fields and the data base will be searched to match these fields.  The 
search is performed as an and function so in order to elicit a match all the search criteria must be 
met.  If you select no criteria and press search a list of all intercepts in the data base will be shown as 
illustrated below. 

 

Figure 63: Search Results Dialog 
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The user can select a particular record and then press Listen to Audio, View/Edit Transcript, or 
Playback.  Listen to audio will launch the default mp3 player and play the audio.  View/Edit the 
transcript will display the transcript editor as discussed previously.  The Playback link will cause the 
time setting of the audio file control to be set to the starting time of the intercept and the audio 
control will play the audio and display the recorded data. 

The user can also use this screen to delete records and data from the database and to export the 
records for import onto another computer running TargetTrack.  The user can also save or print the 
selected records.  The file is saved in .csv format.   

Pressing the Group Selected will group all the intercepts under one transcript as described in 
Grouping Intercepts 

Pressing the XML Export button will export the selected records into an XML formatted file as 
described in Exporting to an XML File. 
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ACCESSING THE TRANSCRIPT 

A transcript can be accessed in two ways.  The user can enter the approximate date and time of the 
transcript into the audio control time setting.  The audio file will then be displayed in the audio file 
control and the user can then right click on the file and choose edit transcript.  The second way to 
access the transcript is by searching the database. 

A typical blank transcript is shown below. 

 

Once displayed the fields can be filled out and saved to the data base. 
 

Figure 64: Transcript 
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ADDING SPEAKERS 

The speakers in the transcript consist of a list of the speakers' names and their locations.  The 
locations can be blank. To add a speaker type in the speaker's name and location.  Another way to 
add a speaker is by using the context menu on the map.  The figure below illustrates this procedure.  
With the Transcript Editor displayed, right click on the map at the location you want to add the 
speaker.  Select Add New Speaker at this location and a new speaker will be added to the 
speaker list. 

 

Figure 65: Adding Speakers to a Transcript 
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The figure below shows the result. Click on the word speaker and you can edit the speaker's name. 

 

Figure 66: Entering the Speaker’s Name 
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You can also set the speaker's location using the map as shown below.  With the Transcript Editor 
showing select the speaker you want to set the location of.  Right click on the map and select Set 
Speaker Location.  The speaker location will be set to the location of the mouse click. 

 
 

Figure 67: Setting the Speaker's Location 
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GROUPING INTERCEPTS 

After receiving a number of related intercepts it is possible to assign all related intercepts to one 
transcript.  To form a group perform a search on the database to display the intercepts you wish to 
group.  The figure below shows the results of a search.  Check the intercepts you want to group and 
press Group Selected 

 

Figure 68: Grouping Intercepts 
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The software forms a group and assigns a new transcript to the group.  The search display will 
display all the grouped transcripts in bold and Transcript Editor window will be displayed as depicted 
in the figure below. 

 

Figure 69: Grouped Intercept Display 
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Figure 70: Transcript Editor View of Grouped Intercepts 
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The Transcript Editor displays the transcript information and a list of all the intercepts included in 
the transcript.  Clicking on any one of the intercepts will display the data associated with the 
intercept. 

An intercept can be removed by right clicking on it and selecting Remove Intercept.  The audio file 
can be played or the intercept played back in TargetTrack by selecting Listen To Audio or Playback 
respectively. 

An intercept can be added by pressing down and holding the mouse button over an intercept in the 
Search Results and then dragging and dropping the intercept onto the Intercept list in the Transcript 
Editor. 
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EXPORTING TO AN XML FILE 

To export the records to an XML file select the files you want to export in the Search Results 
window and press the XML Export button.  The following dialog box will be displayed. 

 

Figure 71: XML Export of Intercepts 
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At this point you can select which fields of the database you wish to export and change the names of 
the fields if you would like.   

Clicking on one of the nodes of the tree will display the database field name at the bottom of the 
tree view as shown above.  To change the XML tag value simply click on the node and edit the name 
or right click on the node and select Edit as shown below. 
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To exclude the field from the export remove the check mark from the field. 

The figure below shows an edited list. 
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Press the Export button and a save file dialog will be displayed allowing you to enter the name and 
directory of the file. 

The listing below shows the a single record export using the structure above 

 

After the first use of XML Tag Selector dialog subsequent uses will use the structure of the previous 
export.  During editing the user can revert to the last saved structure by pressing the Revert 
button.  To revert to the default values press the Default button. 
 

IMPORTING RECORDS 

Records can be imported from databases on other computers that are running TargetTrack.  The 
import files are created on another computer by using the search facility and exporting records to a 
file.  To import these files onto your computer, copy the file onto your computer and then select 
Import from the Data menu.  Open the file you want to import and these files will be imported 
into your database. 

Assume you are going to import data from Computer 1 to Computer 2.  On computer 1 select 
Search from the data menu.  Use the Search Form (see Searching the Database above).  Use the 
search criteria to display the data base records you are interested in.  Typically you would use a 
date/time range and perhaps a frequency to get the records you want.  Next click the Check All 
button to select all the records.  Then press Export Selected.  A standard save file dialog will 
appear.  Name the file and save it. 

To import the data to Computer 2, select Import from the Data menu.  Select the file you want to 
import and press Open and the data will be imported. 

TargetTrack has the ability to import files that were recorded on multiple computers at the same 
time.  This may happen if there are several sites in a geographic region and the computers are 
operating independently.  In other words, the direction finders are not on a network and local 
computers are collecting the data at each site.  To import multiple files, first export the data you 
want to use from each of the computers and then select Import from the Data menu.  Select all 
the files you want to import and press Open.   TargetTrack will combine data from the computers 
and enter it into the local database. 
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REPAIRING THE DATABASE 

Redundancy of data is built into TargetTrack in that the MP3 header file contains the same 
information as the database itself.  If the database gets corrupted the database can easily be rebuilt 
using the MP3 header file information.  Select Repair Database from the Data menu and 
TargetTrack will rebuild the database using the mp3 files stored in the Data directory. 

This feature can also be used in case one of the mp3 files or intercept data files gets deleted or 
corrupted. 
 

PURGING THE DATABASE 

The database can be purged of all records and files or you can purge records imported from other 
networks or training packages.  To purge all records select Data->Purge Database->Purge All 
Records.  To purge records imported from other networks or records from a training package 
select Data->Purge Database->Network Name.  

Warning! Purging the database deletes all records and files.  These records and files are not 
recoverable.  Use caution when using this command.  

 

MAKING TRAINING PACKAGES 

TargetTrack make training packages using either previously collected data or the program can 
generate simulated data. 
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MAKING A TRAINING PACKAGE FROM PREVIOUSLY RECORDED INTERCEPTS 

You can use previously recorded data to make a set of intercepts to be used for training purposes.  
To generate a training package you first select the intercepts you want to use and then you can edit 
the start time and frequency of each intercept.  In this way you can take intercepts collected over a 
long time period and compress them into a shorter time period. 

To make a training package select Search from the Data menu and use the search criteria to display 
the data you want to use to make the training package.  In the search results window check the 
intercepts that you want to include in the training package as shown below. 

 

Figure 72: Selecting Intercepts for a Training Package 
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Press Make Training and you will be asked to enter the name of the training package.  Once a 
name is entered the following dialog box will be displayed. 

 

Figure 73: Generating a Training Package from Actual Data 
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Now use the controls on the right to set the Up Time for each intercept.  Once you've arranged 
the files the way you want them press the Generate button and intercepts will be created and 
entered into the database.  After the intercepts have been generated the Generate button turns into 
an Accept button.  If you are happy with the package press the Accept button and the Search 
results dialog will again be displayed with the training package intercepts shown.  The figure below 
illustrates this  

 

At this point the training package is in the data base and ready for use on the computer that it was 
generated on.  If you want to use it on other computers simply press the Export Selected button 
and create an export package that can be imported on other computers.  After exporting the 
package it can be removed by pressing the Delete Selected button. 
 

Figure 74: Setting the Up Time and Down Time of Actual Data 
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MAKING A TRAINING PACKAGE FROM SIMULATED DATA 

To make a training package from simulated data you must first obtain some audio files.  The audio 
files can be prerecorded audio or you can use an application such as Audacity 
http://audacity.sourceforge.net/ to record audio files and save them as mp3 files.  For the most 
realistic scenarios using multiple targets, use recording software and note the length of time each 
speaker (target) is present.  For convenience it is best to store all the recorded audio files in one 
folder (directory).  

Once you have audio files launch TargetTrack and select Design a Training Package from the 
File menu.  The following dialog will be displayed 

 

Figure 75: Simulated Data Training Package 
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Select a name for the training package by typing in a Package Name.  Press the Add Audio Files 
button and go to the directory where you saved the audio files you wish to use.  Select the files as 
shown below and press OK. 

 

Figure 76: Selecting the Audio Files for the Simulated Training Package 
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The dialog window will appear as shown below.  Notice that the file names are changed to reflect the 
naming convention used by TargetTrack. 

 

Figure 77: Simulated Training Data Dialog after Importing Audio Files 
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Each audio file represents an intercept.  The start date and time of the group of intercepts 
represented by the file list can be changed by entering the desired start date in the Start Date field 
above the table.  The frequency of all the intercepts can also be changed.  The gap between 
intercepts is set to a default value of 20 seconds; however you can change this to be whatever you 
want. 

Next enter the site names and locations you wish to use.  Click in the name field and enter a name.  
To enter a location you can type in the location or place your mouse on the map, right click, and 
select Copy Location.  Click in the location field in the table and right click and select Paste or 
type Ctrl-V.  An example with three sites is shown below. 

 

Figure 78: Entering Site Data for Simulated Data Training Package 
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Next select the intercept that you would like to enter a target for and select the Name field in the 
Targets table.  Enter a target name (default would be Target x) and enter the location, transmission 
power, duration, and gap time for the target.  When you first enter a target the power, duration, and 
gap time will default to fill the duration of the intercept.  The gap time is the time between when the 
first target stops transmitting and the second target begins transmitting.  Repeat this process for all 
other targets you want to enter.  An example of two targets is shown below. 

   

If you would like to use these same targets for all intercepts press the Add Targets to All 
Intercepts button.  If not move to the next intercept and enter the target information.  After 
entering the target information you can edit the values to whatever you want.  You can delete 
intercepts, targets, or sites by clicking on the left side of the row to select the entire row and then 
pressing the Delete key. 

When you've entered all the necessary data press the Generate button.  If the generation is 
successful the Generate button will change to Play.  If you want to view the generated training 
package press the Play button and TargetTrack will playback the training package.  You can modify 
the training package at any time and generate a new one with the same name or a different one. 

To export the training package for use on a different computer use the Export feature of the 
database. 
 

Figure 79: Entering Target Data for Simulated Data Training Package 
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VIRTUAL SITES 

Virtual sites allow the user to manually create a site and enter a bearing for that site.  This would be 
used if a mobile or remote site did not have data communications with the site where TargetTrack is 
being run.  In this case an operator could verbally convey his location and the bearing to the target 
and the TargetTrack operator could enter the data into a Virtual site.   

To construct a Virtual Site, right click on the map and select Add New -> Virtual Site.  A site with 
a V displayed on it will be shown at the location where the user clicked.  To enter a bearing for the 
site right click on the site and enter the bearing followed by the Enter key as shown below 

 

Figure 80: Virtual Site Bearing Entry 
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The site quality can be set also if desired to reflect the accuracy of the bearing measurement. 

The virtual site can be moved by selecting the Site Move tool in the map tool bar and dragging the 
site to a location. 

 

PLACEMARKS 

Creating Placemarks 

TargetTrack allows the user to insert places of interest on the map.  To insert a placemark, right 
click on the map at the location that you would like to add it.  The following dropdown menu will 
appear 

 

 

Select the icon that you want to use for the placemark, and the following dialog will be displayed 
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Enter the name of the placemark in the Description text box and press OK. 

Editing Placemarks 

To Edit a placemark right click on the placemark to display the following context menu 

 

Select a different icon or edit or delete placemark. 

 
 

CALIBRATION 

Sites can be calibrated to a radio frequency source at a known locations.  These sources are referred 
to as beacons.  To set up a beacon in TargetTrack right click on the map and select Add New -> 
Beacon from the pop up menu.  A round site with a B on it will be displayed.  The frequency of the 
beacon is set by right clicking on the beacon site and entering the frequency as shown below. 

 

To calibrate sites to a Beacon first select the sites using the left mouse button.  Hold down the shift 
key to select multiple sites.  Next right click on the beacon site and select Calibrate to Beacon.  The 
system will tune the site to the calibration frequency perform the calibration and then return the site 
to its previous frequency. 
 

Figure 81: Calibration Menu 
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MOBILE OPERATION 

TargetTrack can be used as a standalone direction finder in a mobile environment.  By using saved 
sites a user can triangulate on a target.  To do this the mobile must first receive a signal from the 
target.  When the operator determines that the bearing is good he presses the Insert key and the 
source is saved to the screen as a different color.  The vehicle is then driven to a different location 
and the process is repeated.  Once two bearings are obtained, TargetTrack can estimate the location 
of the target.  The operator can obtain more bearings from other locations to further narrow down 
the target location.  If the operator determines that a bad bearing was entered the bearing can be 
deleted by selecting the saved site with the mouse and pressing the Delete key. 

When a mobile site is the primary site the follow display is shown in the lower right hand corner of 
the screen.  The display shows the bearing relative to the vehicle.  This display is useful when you are 
close to the target and are trying to drive up on the target.  The Insert button functions the same 
way the Insert key functions and the Clear button functions the same way the Delete key 
functions. 

 

 

 
 

REMOTE OPERATION BY ANOTHER PROGRAM 

TargetTrack allows another program to have limited control over the operation of TargetTrack.  A 
TCP/IP server furnishes the interface.  The TCP/IP server is on port 10100 and can be used  

1) As a local connection if the software is installed on the same computer as TargetTrack 
2) As a remote connection on a LAN allowing software on another computer to control 

TargetTrack 
3) As a remote connection on a WAN (e.g. Internet) by configuring an open port on any firewalls. 

Figure 82: Mobile Compass Rose Display 
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Commands and data are exchanged in XML format.  The message will consist of a 16 byte header 
followed by an XML message.  The first two bytes of the header are the length of the message in 
bytes (including the header).  The remaining 14 bytes of the header are for future use. 

The entire interface with the XSD Schema is described in the TargetTrack Remote Control Interface 
Document available on the installation CD and on the Doppler  web site. 
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